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1. ОСНОВЫ РАБОТЫ С ПРОГРАММОЙ

1.1. Интерфейс

Программа FrameMaker создавалась в те далекие времена, когда не было
ясных представлений о технике управления сложными программами. Интер-
фейсные шероховатости, которыми отличались все ранние издания програм-
мы, полностью исправлены в ее последних версиях. Программа получила сов-
ременный и гибкий интерфейс пользователя, основанный на прошедших
испытание временем приемах взаимодействия человека и компьютера. Глав-
ное в новом облике программы – это настраиваемые панели, которые можно
объединять в группы по признаку функционального подобия или частоты ис-
пользования. Многочисленные настройки разрешают пользователю создавать
и сохранять удобную конфигурацию рабочей среды с упорядоченным распо-
ложением необходимых панелей и окон.

Рис. 1.1. Окно программы
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После запуска программы и открытия документа на экран будет выведено
окно, примерный вид которого показан на рис. 1.1. Рассмотрим его основные
компоненты:

1 – главное меню программы;
2 – главная инструментальная панель;
3 – закладка активного документа;
4 – закладка открытого документа;
5 – окно активного документа;
6 – элементы управления рабочей средой;
7 – группа закрепленных панелей;
8 – закладки управляющих пультов;
9 – строка состояния;

10 – плавающая панель.

1.1.1. Главное меню

Главное меню (main menu) является основным диспетчерским пультом
программы (см. рис. 1.1, номер 1). Оно открывает доступ к средствам управ-
ления (командам, панелям, диалоговым блокам), с помощью которых выпол-
няется вся работа по созданию и форматированию документа и настройка
программы.

Каждый раздел главного меню объединяет группу функционально близ-
ких команд, доступ к которым возможен через систему вложенных меню.
Приведем краткое описание главных разделов:

• File (Файл) – объединяет основные файловые команды, команды печа-
ти, вызов вспомогательных утилит и настройки программы;

• Edit (Правка) – содержит команды отмены и повторения действий поль-
зователя, команды для работы с буфером обмена и запуск процедур по-
иска и проверки орфографии;

• Format (Формат) – включает в себя команды форматирования символов
и абзацев, а также средства планировки и структурирования страниц;

• View (Вид) – в этот раздел входят средства управления видами, режи-
мами отображения экрана и команды вызова инструментальных пане-
лей и диалоговых блоков;

• Special (Специальный) – содержит набор средств для создания слож-
ных документов: команды гипертекстовой разметки, средства для
вставки маркеров и переменных, команды генерации порожденных
файлов (оглавлений и списков);

• Graphics (Графика) – объединяет разнообразные команды, предназна-
ченные для работы с графикой и вызова внешних графических редак-
торов;

• Table (Таблица) – в раздел входят команды для создания, редактирова-
ния и форматирования таблиц;

• CMS – содержит команды, предназначенные для взаимодействия с си-
стемами управления контентом (content management system);
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• Window (Окно) – включает в себя стандартные команды управления
многооконным интерфейсом;

• Help (Помощь) – объединяет различные средства поддержки пользова-
теля: интерактивную подсказку, запуск процедуры регистрации, поиск
и загрузку обновлений и др.

Система меню программы построена по иерархическому принципу. От-
дельные пункты меню могут открывать доступ к разделам следующего уров-
ня, которые, в свою очередь, могут содержать еще более глубоко вложенные
подменю. Например, если щелкнуть по разделу главного меню Edit, а затем
выбрать пункт Copy Special, то раскроется выпадающее подменю, представ-
ленное на рис. 1.2.

Рис. 1.2. Пример вложенного меню

В программе приняты стандартные правила работы с системой меню. На-
помним их. Пункты меню, которые отмечены с правой стороны черным тре-
угольником, содержат вложенные подменю. Подменю раскрывается, если под-
вести курсор к его названию. Пункты меню без треугольных пометок
представляют собой команды, которые выполняются по щелчку мыши. Ко-
манды, после имени которых стоит многоточие, открывают окна диалога. Это
значит, что для выполнения такой команды требуется задать в специальном
диалоговом окне какие-то дополнительные параметры. В примере, показан-
ном  на рис. 1.2, такой командой является Spelling Checker (Проверка орфогра-
фии). Названия недоступных разделов и команд меню – серого цвета. Самые
востребованные команды могут запускаться на выполнение при помощи соче-
тания горячих клавиш. Такие клавиатурные комбинации приводятся после на-
звания команды. 

Если слева от названия раздела меню стоит специальный
маркер (галочка), это значит, что данная команда уже выполнена. Такие дирек-
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тивы действуют как двоичные переключатели. Выполнение команды включа-
ет какой-то режим работы программы, повторное выполнение отменяет его.
Особенно много подобных средств в разделе главного меню View. 

FrameMaker предлагает несколько способов выполнения команд:
• навести курсор на пункт меню с названием команды и щелкнуть левой

кнопкой мыши;
• навести курсор на пункт меню с названием команды и нажать на клави-

шу Enter;
• выполнить команду при помощи клавиш-акселераторов (только в ла-

тинской раскладке). Для этого нажать клавишу Alt, после чего в назва-
ниях разделов главного меню будет подчеркнута одна буква. Это
обозначение так называемой клавиши-акселератора. Команда запуска-
ется последовательным нажатием клавиш-акселераторов, соответству-
ющих ее положению в иерархии вложенных меню. Например, чтобы
выполнить команду Spelling Checker (Поверка орфографии) (см.
рис. 1.2), надо нажать Alt,  а затем последовательность латинских букв
e, l (Edit => Spelling Checker); 

• некоторые команды можно запустить при помощи комбинации «горя-
чих клавиш». Такие клавиатурные наборы указываются с правой сто-
роны от названия команды. Из изображенных на рис. 1.2 такими
командами являются Paste (Ctrl+V), Select All in Flow (Ctrl+A) и др.;

• кроме стандартных для Windows-приложений  комбинаций с использо-
ванием управляющих клавиш Ctrl, Alt, Shift многие команды
FrameMaker можно выполнить при помощи так называемых Esc-после-
довательностей. Например, для вывода на экран панели для вставки
маркеров надо нажать клавишу Esc, а затем s m. Перечень многочи-
сленных Esc-последовательностей, доступных в программе, приводит-
ся в приложении (только в латинской раскладке);

• запуск команд при помощи кнопок инструментальных панелей.
Количество пунктов и подпунктов главного меню можно менять. Команда

View => Menus => Quick (Вид => Меню => Короткое) сокращает количество
разделов, оставляя только самые нужные команды. Команда View => Menus =>
Complete (Вид => Меню => Полное) восстанавливает главное меню в полном
виде.

1.1.2. Главная инструментальная панель

Главная инструментальная панель расположена под заголовочной строкой
и объединяет кнопки вызова наиболее востребованных команд программы
(рис. 1.3). В документации на пакет и в интерактивной справке она именуется
Quick Access Bar, что дословно можно перевести как «панель быстрого досту-
па». Но подобный элемент интерфейса, облегчающий использование основ-
ных ресурсов и средств, содержится чуть ли не в каждом Windows-приложе-
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нии и в большинстве случаев называется главной панелью. Будем следовать
этой традиции. 

Рис. 1.3. Главная панель

Рассмотрим содержимое  главной панели:  
1 – Help (Помощь). Вызов интерактивной подсказки;
2 – New (Новый). Создание нового документа;
3 – Open (Открыть). Открытие документа;
4 – Save (Сохранить). Сохранение документа;
5 – Import (Импортировать). Импорт внешнего графического или тексто-

вого файла;
6 – Print (Печать). Вызов настроек печати и вывод на печать;
7 – Toggle View Only (Переключить в режим просмотра). Переводит экран

в режим просмотра. В этом режиме недоступны средства редактирова-
ния документа, который разрешается только пролистывать;

8 – Clear (Очистить). Удаляет помеченный фрагмент документа (текст, ри-
сунок, таблицу и прочее);

9 – Cut (Вырезать). Переносит помеченный фрагмент в буфер обмена;
10 – Copy (Копировать). Копирует помеченный фрагмент в буфер обмена;
11 – Paste (Вставить). Вставляет содержимое буфера обмена в документ;
12 – Undo (Отмена). Отмена пользовательских операций;
13 – Redo (Повтор). Повторение отмененных пользовательских операций;
14 – Repeat (Повторное исполнение). Повторное исполнение последней

операции пользователя;
15 – History (История). Вызов панели History;
16 – Character Catalog (Каталог символьных стилей). Вывод на экран ката-

лога символьных стилей;
17 – Paragraph Catalog (Каталог абзацных стилей). Вывод на экран катало-

га абзацных стилей;
18 – Table Catalog (Каталог табличных стилей). Вывод на экран каталога

табличных стилей;
19 – Find/Change (Найти/Заменить). Запускает команду поиска и замены;
20 – Find Next (Продолжить поиск). Команда продолжения поиска;
21 – Spelling Checker (Проверка орфографии). Запускает команду проверки

орфографии;
22 – Anchored Frame (Прикрепленный блок). Вставка прикрепленного бло-

ка; 
23 – Footnote (Сноска). Вставка сноски;
24 – Insert Table (Вставка таблицы). Запускает команду создания таблицы;
25 – Symbols (Символы). Выводит на экран меню для вставки специальных

символов;
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26 – Preview Filter by Attribute (Предварительный просмотр фильтрации
атрибутов). 

1.1.3. Инструментальная панель символьного форматирования

Носителями шрифтовых оформительских атрибутов в программе могут
быть отдельные символы, символьные цепочки и абзацы. Символы и цепочки
определяют сами себя, тогда как абзацем или параграфом называется тексто-
вый фрагмент, ограниченный специальным непечатаемым символом (конец
абзаца), который можно увидеть только на экране монитора в специальном ре-
жиме отображения документа.    

Инструментальная панель Text Formatting (Символьное форматирование),
показанная на рис. 1.4, объединяет кнопки вызова наиболее употребительных
средств форматирования произвольных текстовых фрагментов. Она выводит-
ся на экран командой главного меню View => Toolbars => Text Formatting
(Вид  Инструментальные панели => Символьное форматирование). 

Рис. 1.4. Панель Text Formatting

Рассмотрим содержимое этой панели:
1 – Plain (Обычный). Задает стандартное начертание символов;
2 – Bold (Полужирный). Задает полужирное начертание символов;
3 – Italic (Курсивный). Задает курсивное начертание символов;
4 – Underline (Подчеркнутый). Задает подчеркнутое начертание символов;
5 – Increase Font Size (Уменьшить размер шрифта). Уменьшает размер

шрифта помеченных символов;
6 – Decrease Font Size (Увеличить размер шрифта). Увеличивает размер

шрифта помеченных символов;
7 – Lowercase (Строчные). Превращает все символы помеченного тексто-

вого фрагмента в строчные;
8 – Initial Caps (Первая прописная). Первые буквы всех помеченных слов

становятся прописными, остальные буквы – строчными;
9 – Uppercase (Прописные). Все символы помеченного фрагмента стано-

вятся прописными;
10 – Font (Шрифт). Служит для выбора шрифта;
11 – Size (Размер). Служит для выбора размера.

1.1.4. Инструментальная панель абзацного форматирования

Инструментальная панель Paragraph Formatting (Абзацное форматирова-
ние), показанная на рис. 1.5, служит для вызова самых актуальных команд
форматирования параграфов. Для вывода этой панели на экран можно вос-
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пользоваться командой View => Toolbars => Paragraph Formatting (Вид  Ин-
струментальные панели => Абзацное форматирование).

Рис. 1.5. Панель Paragraph Formatting

Рассмотрим состав этой панели:
1 – Left Tab (Левый табулятор). Выбирает левый табулятор ;
2 – Center Tab (Центральный табулятор). Выбирает центральный табуля-

тор;
3 – Right Tab (Правый табулятор). Выбирает правый табулятор;
4 – Decimal Tab (Десятичный табулятор). Выбирает десятичный табуля-

тор;
5 – Left (Левый). Задает выравнивание по левому краю (левая выключка);
6 – Right (Правый). Задает выравнивание по правому краю;
7 – Center (Центральный). Задает выравнивание по центру;
8 – Justify (По ширине). Задает выравнивание по ширине;
9 – Single (Одинарный). Устанавливает одинарный межстрочный интер-

вал;
10 – 1.5 (Полуторный). Устанавливает полуторный межстрочный интервал;
11 – Double (Двойной). Устанавливает двойной межстрочный интервал;
12 – Custom (Заказной). Вызывает диалоговый блок для выбора нестандар-

тного значения межстрочного интервала;
13 – Space Between (Расстояние между). Служит для выбора расстояния

между смежными абзацами;
14 – Paragraph Formats (Форматы параграфов). Предназначен для выбора

абзацного стиля.
Обе инструментальные панели символьного и абзацного форматирования

обладают свойством контекстной чувствительности. Они показывают атрибу-
ты форматирования помеченного текстового фрагмента: строки символов или
абзаца. 

1.1.5. Окно документа

Каждый документ в программе отображается в отдельном окне (рис. 1.6).
Рабочее окно документа – это интерфейсный элемент, отвечающий большин-
ству привычных соглашений операционной системы Windows. Его обязатель-
ными атрибутами являются заголовочная строка, строка состояния и линейки
прокрутки (вертикальная и горизонтальная). 

В заголовочной строке (см. рис. 1.6, 3) выводится имя загруженного фай-
ла и расположены три стандартные кнопки, управляющие размером окна.
Строка состояния (см. рис. 1.6, 6) выполняет очень важные функции. Она
представляет собой информационное табло, на котором отображается спра-
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вочная и управляющая информация о редактируемом документе. Кроме того,
она содержит средства масштабирования документа и навигации по страни-
цам. 

При работе с большим документом часто приходится перемещаться меж-
ду его фрагментами, которые не попадают в зону видимости окна. Такой пере-
ход называется прокруткой изображения, скроллингом или панорамировани-
ем. Полосы прокрутки – стандартное средство перемещения по большому
документу (см. рис. 1.6, 7). Во FrameMaker техника работы с ними ничем не
отличается от других приложений Windows. 

Следует отметить: полосы прокрутки – это простое, но не самое эффек-
тивное средство навигации. Программа предоставляет пользователю несколь-
ко дополнительных возможностей перемещения с использованием специаль-
ных команд и клавиатурных ускорителей. 

Рис. 1.6. Окно документа в связанном (a) и свободном (b) состояниях

Содержимое документа располагается в пределах текстовых и графиче-
ских блоков, границы которых изображаются пунктиром (см. рис. 1.6, 5). Тек-
стовый блок представляет собой контейнер, который хранит основной контент
страницы: текст, графические вставки, маркеры, управляющие спецсимволы и
др. Он задает полосу набора и решающим образом влияет на параметры печат-
ного оттиска.

Размерные линейки задают привязку к единой системе координат, служат
для измерения объектов и задают положение табуляторов и горизонтальных
отступов (см. рис. 1.6, 4).
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Рис. 1.7. Ярлыки документов и контекстное управляющее меню

Окно документа может находиться в двух различных состояниях: связан-
ном (см. рис. 1.6, a) и свободном. В первом случае оно занимает все доступное
место окна программы, а на позиции заголовочной строки появляется ярлык с
именем открытого файла. Окно в свободном состоянии находится под контр-
олем пользователя, который по своему усмотрению может установить его раз-
меры и положение.

Преимущества связанного состояния увеличиваются с ростом числа от-
крытых окон.  В этом случае каждое связанное окно представлено ярлыком,
расположенным в верхней части окна программы, поэтому доступно в любой
рабочей ситуации. Нажатие ярлыка делает окно активным и переводит его со-
держимое на первый план. Щелчок правой кнопкой по любому ярлыку выво-
дит на экран контекстное меню с самыми необходимыми командами управле-
ния окнами и документами (рис. 1.7). 

Для того чтобы плавающее окно перевести в связанное состояние, надо
захватить его заголовочную строчку и перетащить к краю окна  программы.
Обратная операция выполняется посредством буксировки ярлыка.  

Для быстрого перемещения между открытыми документами можно ис-
пользовать стандартную клавиатурную комбинацию Ctrl+Tab. 

1.1.6. Строка состояния

Строка состояния – это часть окна документа, которая выполняет очень
важные справочные и управляющие функции (рис. 1.8). 

Рис. 1.8. Строка состояния
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В ней выводятся данные о помеченных объектах и располагаются средст-
ва навигации и масштабирования. Строка состояния обладает свойством кон-
текстной чувствительности – она меняет свой вид в зависимости от существу-
ющей в документе пометки.

 Рассмотрим ее содержимое более подробно:
1 – информационной поле, которое показывает имя активной текстовой

цепочки;
2 – информационной поле, представляющее абзацный стиль помеченного

текстового фрагмента;
3 – информационное поле, показывающее символьный стиль помеченного

текстового фрагмента;
4 – кнопка перехода на первую страницу документа;
5 – кнопка перехода на предыдущую страницу документа;
6 – управляющее поле, которое показывает номер текущей страницы и

служит для перехода на страницу с заданным номером;
7 – кнопка перехода на следующую страницу документа;
8 – кнопка перехода на последнюю страницу документа;
9 – информационное поле, которое выводит номер текущей страницы и

общее количество страниц документа;
10 – управляющее поле, содержащее номер текущей строки;
11 – кнопка перехода к позиции текстового курсора;
12 – кнопка уменьшения масштаба документа;
13 – раздел, который служит для выбора текущего масштаба и настройки

стандартных масштабов отображения;
14 – кнопка увеличения масштаба документа.
○ Символ * (звездочка) в строке состояния играет роль «красного сигна-
ла семафора». Он предупреждает пользователя о рассогласованиях и
отклонениях, существующих в текущем документе. Например, звез-
дочка, поставленная после имени стиля, свидетельствует о наличии
расхождений в форматировании текущего объекта (абзаца или стро-
ки символов) со стилевыми установками. Если документ содержит
несохраненную информацию, то звездочка ставится после общего ко-
личества страниц документа. 

1.1.7. Диалоговые блоки

FrameMaker – мощная программа, объединяющая в себе возможности на-
стольной издательской системы, текстового процессора и графического редак-
тора. Понятно, что все средства и инструменты невозможно отобразить в од-
ном главном меню. Для редактирования сложных документов FrameMaker
предлагает множество дополнительных диалоговых блоков и панелей.

Диалоговый блок представляет собой модальное окно, содержащее раз-
личные элементы управления: кнопки, переключатели, поля. Это окно остает-
ся на экране от момента вызова до закрытия, и в этот период времени оно не
разрешает  переключаться на другие интерфейсные элементы программы. 
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Рассмотрим приемы работы с этими интерфейсными элементами на при-
мере диалогового блока PDF Setup, показанного на рис. 1.9:

1 – переключатель. Служит для выбора некоторой опции или настройки.
Переключатель может находиться в двух состояниях: включенном и
выключенном. Признаком активности служит специальный флажок,
который обычно изображают в виде галочки. Повторный щелчок по
переключателю дезактивирует его и убирает флажок;

2 – закладка диалогового блока. Служит входом раздела диалогового бло-
ка, содержащего множество настроечных параметров, сходных по на-
значению или области применения;

3 – список. Предоставляет выбор из нескольких взаимоисключающих аль-
тернатив. Признаком списка является треугольный ярлычок, располо-
женный в прямоугольном поле справа. Щелчок по ярлычку раскрыва-
ет перечень всех возможных действий, и, чтобы выбрать нужное,
достаточно пометить соответствующее название;

4 – числовое поле. Служит для ввода параметров, которые являются целы-
ми или вещественными числами;

5 – управляющая кнопка. Управляет диалоговым окном;
6 – радиокнопка. Это частный случай переключателя. Радиокнопка предо-

ставляет выбор нескольких взаимоисключающих возможностей. Изо-
бражаются в виде полого круга. Признаком активности кнопки служит
черная точка;

7 – информационное поле. Служит для вывода сообщений или подсказок. 

Рис. 1.9. Пример диалогового блока



1.1. Интерфейс

17

Управляющие кнопки отвечают за те команды, параметры, режимы и дан-
ные, которые пользователь ввел при помощи диалогового блока. Обычно они
изображаются в виде серых прямоугольников с тенью. Самые распространен-
ные кнопки программы:

• Apply (Применить). Применяет параметры, заданные в диалоговом бло-
ке, к помеченному объекту или объектам;

• Set (Установить). Приводит в действие параметры диалогового блока и
отключает его;

• Cancel (Отмена). Отменяет только что заданные параметры и прекра-
щает работу с диалоговым блоком;

• Help (Помощь). Вызывает интерактивную подсказку.
В большинстве ситуаций при работе с диалоговыми блоками нажатие кла-

виши Enter равнозначно выполнению команды Apply, клавиши Esc – Cancel, а
нажатие пробельной клавиши эквивалентно щелчку мышью по активной
кнопке блока.

Рассмотрим несколько дополнительных приемов работы с диалоговыми
блоками. Если заголовочная строка блока выделена синим цветом, то он акти-
вен и можно щелчком мыши или нажатием клавиши Tab (Табулятор) выбрать
необходимый управляющий элемент активного раздела. Сочетание Shift+Tab
позволяет двигаться по интерфейсным элементам в другую сторону. Переме-
щаться по закладкам блока можно при помощи мыши или посредством кла-
виш PgUp и PgDn.

При заполнении числовых полей вещественными числами целую часть от
дробной должна отделять запятая. В большинстве случаев числовые поля не
требуют указания размерности; при необходимости программа сама добавля-
ет единицы измерения. В числовые поля можно вставлять информацию из бу-
фера обмена. Данные неверного формата игнорируются. Так, если ввести ве-
щественное число в поле, предназначенное для целого числа, и попытаться
применить эти данные, то программа просто восстановит исходное значение
числового поля и не сообщит о сделанной ошибке.

Пролистывание длинных списков – это утомительная процедура. Чтобы
сделать ее проще, можно, не раскрывая списка полностью, поместить туда
курсор мыши и просмотреть все пункты с помощью стрелочных клавиш. На-
жатие первой буквы имени списочного элемента (регистр не учитывается) –
это еще один способ быстрой навигации по спискам. 

Интерфейсные элементы многих диалоговых блоков и панелей
FrameMaker могут принимать особое, нейтральное значение. В документации
на программу и некоторых списках оно названо As Is (Как есть). Нейтральное
значение играет роль своеобразного семантического нуля. При выполнении
команд, форматировании символов и абзацев, поиске и т. п. оно не учитывает-
ся или не влияет на объекты документа – иными словами, оставляет данный
признак или параметр в исходном состоянии. Нейтральное значение может
выражаться разными способами:

• ключевым словом As Is в списках и радиокнопках;
• отсутствием каких-либо значений в числовых и текстовых полях;
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• посредством серого фона (для переключателей).

1.1.8. Панели

Существуют диалоговые блоки, к которым приходится обращаться очень
часто, по нескольку раз в каждом сеансе работы с программой. Панель – это
диалоговый блок, который после выполнения своих функций остается на эк-
ране до следующего обращения и убирается по желанию пользователя с помо-
щью специальной команды. Такие окна или блоки иногда называют немодаль-
ными. 

Панели позволяют создать удобную конфигурацию рабочей среды. В по-
следних версиях программы они получили максимальную для современных
пакетов гибкость и настраиваемость. Панели можно перемещать, сворачивать
и разворачивать, объединять в группы и стеки, припарковывать к границам
окна и др. На рис. 1.10 показана панель History в четырех различных состояни-
ях: свернутая (a), плавающая (b), стек (c), группа (d). 

Рис. 1.10. Панель History в различных состояниях

Панели программы различаются своим содержимым, но имеют одинако-
вую технику настройки, основанную главным образом на приеме буксировки
и нескольких простых командах. Приведем сводку основных приемов.

• Открытие. Выполняется при помощи раздела главного меню Window
=> Panels (Окно => Панели) или View => Pods (Вид => Пульты). Кроме
того, вызов некоторых панелей можно осуществить при помощи кно-
пок главной панели и комбинации горячих клавиш. 

• Закрытие. Для закрытия активной панели достаточно нажать кнопку в
виде крестика, расположенную в правой части заголовочной строки.
Другой способ – это команда Close, которая вызывается щелчком пра-
вой кнопкой мыши по заголовочной строке панели. 

• Перемещение. Для перемещения панели достаточно зацепить мышью
заголовочную строку или ярлык и отбуксировать в ее в любое место эк-
рана. На многомониторных системах панели можно перетаскивать
даже на другой экран. 
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• Изменение размеров. Для изменения размеров панели требуется захва-
тить  и перетащить мышкой ее границу. Операцию выполнить проще,
если использовать для этого специальный элемент, расположенный в
нижнем правом углу панели.  

• Закрепление. Закреплением (docking) разработчики пакета называют
состояние панелей, когда они в свернутом виде располагаются в правой
или нижней частях окна программы (рис. 1.11). Чтобы закрепить пла-
вающую панель, требуется перетащить ее на место парковки, удержи-
вая заголовочную строчку. Сигналом готовности операции служит
синяя полоса под курсором мыши, которая показывает местоположе-
ние панели.    

• Группирование. Плавающие панели можно объединить в группу. Груп-
па – это временное образование, которое в некоторых интерфейсных
операциях ведет себя как единое целое (см. рис. 1.10, d). К таким опе-
рациям относятся перемещение, сворачивание, разворачивания, закре-
пление и удаление. Для создания группы следует перетащить панель,
удерживая ее ярлык, и бросить в верхней части другой плавающей па-
нели или существующей группы. Перемещение и закрепление группы
выполняются при помощи буксировки заголовочной строки.

• Разгруппирование. Для извлечения панели из состава группы надо пе-
реместить ее на свободное место окна программы, удерживая ярлык. 

• Создание стека. Стеком в программе называется множество плаваю-
щих панелей с вертикальным расположением (см. рис. 1.10, с). Для со-
здания подобной структуры надо перетащить плавающую панель к
нижнему краю другой панели или существующего стека. Стек панелей
ведет себя как единый объект в тех же операциях, что и группа. 

Рис. 1.11. Закрепленные панели
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Многие панели, например Paragraph Designer (Дизайнер абзацев), Charac-
ter Designer (Дизайнер текста) и др., реагируют на действия пользователя,
даже находясь в неактивном состоянии. Так, поля и переключатели дизайне-
ров отображают информацию о форматировании текущего абзаца и помечен-
ного текста. Такое свойство интерфейсных элементов принято называть кон-
текстной чувствительностью.

1.1.9. Управляющие пульты

Некоторые управляющие панели отличаются от обычных панелей про-
граммы своим статусом и поведением. В документации такие панели называ-
ются Pods (Пульты). Это наиболее востребованные средства управления пу-
бликацией, обладающие дополнительными возможностями навигации по
большим документам и книгам1. Для вывода пульта на экран следует выпол-
нить команду View => Pods. По умолчанию они прикрепляются к нижней ча-
сти окна документа. Конфигурирование пультов почти не отличается от обыч-
ных панелей – их можно перетаскивать, припарковывать, сворачивать,
группировать и т. д. по желанию пользователя.

Рассмотрим основные свойства этих объектов на примере управляющего
пульта Insets (Вставки), показанного на рис. 1.12. Он выводит сведения о всех
внешних графических и текстовых вставках и позволяет их обрабатывать.

Рис. 1.12. Управляющий пульт Insets

1 – выбор документа или книги. В этом списке перечисляются все откры-
тые  документы и книги. Из данного перечня можно выбрать необхо-
димый источник, информация которого отображается в нижней части
пульта (2);

2 – основное информационное поле, в котором выводятся сведения об
объектах управления: вставках, маркерах, шрифтах и др. Пульт пока-
зывает список объектов, документы, которые являются источниками,
и номера страницы, на которых объекты расположены. Если щелчком

1 Книгами во FrameMaker называются большие публикации, состоящие из нескольких
автономных файлов. Работа с книгами подробно описывается в отдельной главе.
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пометить запись этого списка, то выполняется переход на искомую
страницу и соответствующий объект выделяется, то есть программа
реализует все подготовительные операции для редактирования. Двой-
ной щелчок по записи, как правило, отображает объект в окне доку-
мента и вызывает специализированное средство для редактирования
этого объекта;  

3 – кнопки управления и редактирования. Набор этих средств зависит от
типа управляющего пульта. В их число обычно входят команды удале-
ния перехода к месту размещения и редактирования объекта; 

4 – кнопка Refresh (Обновить). Запускает команду обновления содержи-
мого управляющего пульта;

5 – поле, предназначенное для поиска объектов в управляющих пультах
большого объема;

6 – абзацные стили, которые выбраны для указания местоположения объ-
екта в документе.    

Рассмотрим последнее свойство более подробно. В примере на рис. 1.12
положение объекта в документе уточняется при помощи абзацных стилей
Heading1 и Heading2. Программа находит ближайшие предшествующие вхо-
ждения этих стилей и выводит их содержимое в информационном поле пуль-
та. Если перед объектом нет образцов этих стилей, то соответствующие пози-
ции остаются пустыми. Так, помеченному объекту в примере, показанном на
рис. 1.12, предшествуют вхождения «1.1. Интерфейс» и «1.1.8. Панели». 

Рис. 1.13. Диалоговое окно Location Criteria

Имена абзацных стилей можно менять. Для этого следует выполнить ко-
манду главного меню File => Preferences => Pods Location Criteria (Файл =>
Настройки => Критерии расположения) и в диалоговом окне, показанном на
рис. 1.13, ввести требуемые имена абзацных стилей, например 1Head и 2Head.

○ Заголовки информационных подразделов в пультах (Type, Document,
Page и др.) можно использовать для упорядочения записей. Щелчок по
заголовку делает его основным критерием сортировки записей, по-
вторный щелчок меняет порядок перечисления записей на противопо-
ложный.
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1.1.10. Настройка рабочей среды

Под рабочей средой понимается конфигурация окна FrameMaker, которая
определяется совокупностью открытых панелей и их расположением. В про-
грамме есть несколько предустановленных конфигураций рабочей среды, оп-
тимизированных для решения задач определенного вида – обработки графики,
создания контента и др. Кроме того, пользователь может создавать и сохра-
нять собственные конфигурации, учитывающие его предпочтения и осо-
бенности рабочего стиля. 

Основные настройки рабочей среды и ее средства управления сосредото-
чены  в правой части главного меню (рис. 1.14). 

Рис. 1.14. Команды управления рабочей средой

Рассмотрим эти средства:
1 – UI Visibility (Обзор пользователя). Служит для переключения окна про-

граммы в состояние обзора пользователя. В этом состоянии с экрана
убираются все плавающие панели и инструментальные окна, а связан-
ные окна открытых документов распахиваются на все доступное про-
странство. Закрепленные панели сворачиваются, а на их позициях
появляется полоса серого цвета. Если навести курсор мыши на эту по-
лосу, то свернутые панели выводятся на экран и остаются на время ра-
боты, после чего автоматически убираются. Повторное нажатие
кнопки UI Visibility переводит окно документа в исходное состояние. 

Рис. 1.15. Меню для размещения документов
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2 – Arrange Documents (Упорядочить документы). Служит для создания
упорядоченного расположения документов на экране. Нажатие этой
кнопки открывает меню с вариантами размещения нескольких доку-
ментов на экране (рис. 1.15). 

3 – Screen Mode (Экранный режим). Предназначен для выбора одного из
трех стандартных режимов отображения окна программы:
• Standard Screen Mode (Стандартный экранный режим). Это обыч-
ный режим отображения, когда визуализируются все выбранные
пользователем элементы интерфейса;

• Full Screen Mode With Menu Bar (Полноэкранный режим с главным
меню). Окно программы расширяется на все доступное пространст-
во монитора. В свою очередь, отрытые окна документов распахива-
ются, а их ярлыки и заголовочные строки не отображаются. На
экране остаются выведенные ранее панели и инструментальные ок-
на;

• Full Screen Mode (Полноэкранный режим). Экранный режим, в кото-
ром все доступное пространство экрана отводится на отображение
документа. Программа не визуализирует никакие интерфейсные
элементы, включая главное меню. Для выхода из этого режима надо
щелкнуть правой кнопкой мыши в любой точке за пределами тек-
стового блока и выбрать в контекстном меню команды Toggle Screen
Mode (Переключить экранный режим).

4 – Вызывает меню с командами управления рабочей средой.   Перечи-
слим эти команды:
• Authoring (Разработка). Выбор стандартной конфигурации, предназ-
наченной для разработки документа;

• Blank (Пустой). Загрузка минимальной конфигурации без открытых
инструментальных панелей и пультов. Эта конфигурация для опыт-
ных пользователей, управляющих ресурсами программы при помо-
щи горячих клавиш.

• Design (Дизайн). Выбор конфигурации, предназначенной для вер-
стки и форматирования документа;

• Manage Graphics (Управление графикой). Загрузка стандартной кон-
фигурации, предназначенной для редактирования графики.

• Review (Обзор). Загрузка стандартной конфигурации, предназначен-
ной для редактирования и рецензирования документа;

• Save Workspace (Сохранить рабочее пространство). Сохранение
пользовательской конфигурации. После выполнения этой команды
имя новой конфигурации рабочего пространства появится на первой
позиции меню, показанного на рис. 1.14;

• Manage Workspace (Управление рабочим пространством). Вызывает
диалоговое окно, с помощью которого можно переименовать или
удалить пользовательскую конфигурацию;

• Reset Workspace (Восстановление рабочего пространства). Служит
для восстановления активной конфигурации.
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1.2. Клавиатурные сокращения

Комбинации клавиш часто используются для вызова окон и диалоговых
блоков, выполнения команд, форматирования текста и абзацев. Клавиатурные
эквиваленты команд избавляют от необходимости пробираться сквозь слож-
ную систему меню и подменю и ускоряют доступ к ресурсам программы, по-
этому они называются клавиатурными сокращениями или ускорителями.

В программе действует несколько комбинаций с управляющими клавиша-
ми Ctrl, Shift и Alt. Почти все они служат для быстрого запуска команд главно-
го меню. Если команда имеет сокращение, то оно приводится в соответствую-
щем пункте главного меню с правой стороны от имени команды. Например,
нажав клавиши Ctrl+A, можно выделить все содержимое текстовой цепочки,
комбинация Ctrl+S сохраняет текущий документ в файле.

Esc-последовательности – это отдельная группа клавиатурных комбина-
ций, начинающихся с клавиши Esc. Раньше почти каждое приложение, рабо-
тающее под управлением операционных систем UNIX и DOS, имело собст-
венный набор Esc-последовательностей. Первые версии программы
FrameMaker были разработаны для UNIX, а версия пакета для Windows унас-
ледовала большую часть таких последовательностей. 

Esc-последовательности набираются следующим образом: нужно нажать
и отпустить клавишу Esc (Escape), затем набирать литеры в том порядке, в ко-
тором они приведены в описании. Так, клавиатурным эквивалентом команды
печати служит последовательность Esc f p, а для вставки в таблицу дополни-
тельной строки или столбца следует активировать последовательность Esc t a.

Esc-последовательности чувствительны к регистру и языку. Их следует
набирать только в латинице и только в том регистре, который указан в записи
команды. Нельзя путать прописные и строчные буквы! 

Для ввода специальных символов программа использует еще одно не-
стандартное, параллельно-последовательное сочетание клавиш. Оно описыва-
ется формулой: Ctrl+q «символ на клавиатуре». Например, для ввода знака ум-
ножения следует сначала одновременно нажать Ctr+q, потом – цифру 0. Для
ввода длинного тире следует воспользоваться комбинацией Ctrl+q Shift+q.

Пользователям, которые привыкли к интерфейсу Windows, техника Esc-
последовательностей может показаться странной и архаичной. На самом деле
этот прием имеет много достоинств. Esc-последовательности легко запомина-
ются, поскольку большинство их обозначений напоминает о названии или со-
держании команд. Клавиатурные сокращения с Ctrl, Shift и Alt набираются од-
новременно; в тех случаях, когда применяется больше трех клавиш,
расположенных в разных частях клавиатуры, от пользователя требуется гиб-
кость пальцев профессионального пианиста. Esc-последовательности вводят-
ся по очереди, что значительно удобнее. Наконец, многие из них одинаковы
для пакетов на платформах Windows и UNIX. Кроме того, таких Esc-последо-
вательностей намного больше, чем стандартных комбинаций управляющих
клавиш, почти каждая команда программы имеет свой Esc-эквивалент.
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